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Hello everybody,  

Welcome to this month’s Viewpoint.  

The Club AGM was held last month, and I would like to  

congratulate all my committee team members for being  

re-elected and I look forward to working together, with all of 

you again, to continue to better serve our club. On the night 

we welcomed Mr Rick Cumming to the AGM. Rick is the  

current Vice President and a director of the Castle Hill RSL 

group. It is our privilege to have Rick on-board as our Patron, 

as we continue to grow and expand our club in the Hills  

community. I would also like to thank Tony Spence for again  

running our elections.  There are still opportunities for club 

members to volunteer for the various committees that run 

our activities during each month. 

September will be a very busy month for our club as there are 

many activities happening simultaneously. These include;  

a lecture from Ken Duncan, a training presentation on a  

photographer’s accessories, Special Interest Group meetings, 

a mid-week outing to the Australian Reptile Park, a Getting to 

Know Your Camera Day and the FCC Interclub competition, in 

which we have had some success over the past few years 

For the FCC, don’t forget to submit your images and/or prints 

to us as we need these images to submit as our club’s entry.  

A portfolio presentation night is being planned at the end of 

the year for the SIGs to showcase their works to the club.  

Last, but not least, we are approaching the time for the Club’s 

AV competition with the subject of Water.  The entries will be 

judged in October and shown in November 

The management committee is working diligently to  

investigate the entry of Junior Members aged 16-18.  We have 

consulted with the RSL and other RSL based sporting clubs 

and will bring a recommendation regarding a change to the 

Club Constitution in the near future.  We are also continuing 

to work on the Club’s website and work has commenced on 

resolving some of the outstanding issues with a new supplier 

involved. 

We recently had a successful trip to the Japanese Gardens at 

Auburn. There were a variety of things to see there ranging 

from a blossom tunnel, ducks and geese, bees on the  

blossoms and a variety of people in national costumes.  Please 

visit the Members Judging page to vote on the submitted  

images. 

The August Training night was also interesting, with Sony 

coming show their wares and demonstrate some advanced 

capabilities.  Members were impressed with the capabilities 

of the top of the line camera and were given the opportunity 

to try it for themselves. 

Well, that’s all I have for you this month, please keep a look 

out for news at our club’s website as well as our email  

reminder notice.  

 

Until next month, happy snapping!  

 

 

 

Regards 

Roger King  

 
President 

Castle Hill RSL Photography Club 

From the President 
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Hello Readers 

It is with trepidation that I take over the editing of 
this great magazine/journal. 

Previous editors, most recently Rosa Doric, have set 
an amazingly high standard. 

Indeed, I have been in awe of this magazine and 
have been reading it avidly ever since I joined the 
club 3 years ago. 

Rosa and Ric have helped me produce this edition 
so it’s not quite my first. 

Permit me to introduce myself in the next section, 
“Meet our Members”. 

Here I am with our lecturer for September,  
Ken Duncan (he’s the one with the blouse!) 

 

 

Cheers  

Barry Wilkins 

editor@chrslphotographyclub.org 

mailto:editor@chrslphotographyclub.org
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Barry Wilkins 

Also known as Howard de Winton 

Why Howard de Winton? 

Well, I thought I would publish  

photographs under a pseudonym.  

Barry Wilkins takes photographs, 

Howard de Winton issues only 

those that are worthy of being 

printed and hung on a wall. Howard 

is my middle name and ‘de Winton’ 

is an ancestral name, from Norman 

French, of some of the Wilkins’s. 

Tell us about how you first ven-

tured into photography.  

I have always loved what I see 

around me, especially the grandeur  

of nature. At age 10 I had what was 

even then (early 60s) an old collaps-

ible bellows camera, black and 

white, of course. I have nothing left 

from then except this photo of me.  

Later I had a Contax SLR with a Zeiss 

50 mm lens and that served me for 

decades, taking mostly colour 

transparencies. I have over 1000 

images. 

What do you use now.  

10 years ago I bought a Canon 5D 

Mk II with three zoom lenses, and 

that serves me well. I am now 

blessed with a Phase One XF with 

100 Mp 52 mm sensor and six fixed 

focal length Schneider-Kreutznach 

lenses. I have to choose carefully 

because the whole lot weighs a 

ton! 

What would you like to achieve 

with your photography? 

Although I would like to have a go 

at something different, up to now  

I have concentrated on landscapes. 

I like to find places that no-one has 

photographed. I have a favourite 

spot in the Wollemi wilderness 

which takes two hours by SUV on 

tarmac, then one hour on dirt, then 

three hours walk. Right at the end 

of the walk, an amazing vista opens 

up. I have been there twice,  

sleeping under the stars (a few  

metres from the edge of a 200 m 

cliff) for two nights, but have never 

found the right conditions and light. 

No, I’m not going to reveal its loca-

tion! It’s on the next page. 

 

 Meet our members... Barry Wilkins 
Our new Viewpoint editor 

 

This is my 

Facebook 

photo! 

I was 4! 

I once had 

hair! 
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Tell us about how you first came to 

CHRSLPC and what the club means 

to you? 

I knew about the club from friends  

I made, on trips with Ken Duncan, 

and eventually decided to come. 

Any favourite photographers 

whose work you admire and why?  

I am a long-time student of Ken 

Duncan who is a friend. I first  

desired to imitate him, but now 

I am trying to create my own story. 

I also have met and admire Glenn 

Mckimmin, John Wiseman, Leo 

Meier, and Andris Apse and Petr 

Hlavacek, both on the west coast of 

New Zealand south island. 

Do you have a photographic 

‘moment/adventure’ you could 

share? 

An adventure was to photograph a 

rarely visited waterfall and plunge 

pool in the Daintree (Cassowary 

Fall), crossing private land to get 

into the back of a national park, 

then waiting hours for the light to 

be right, swimming with turtles, 

perch and huge eels while my  

camera was ready and waiting for 

stitched panorama. I got it! 

Is there anything “different” about 

your photography. 

Well, look, I am a scientist (doctor, 

biologist, mathematician). I don’t 

like aspect ratios that are rational 

numbers (3:1, 2:1, 3:2, 16:9 etc).  

I have my own favourite ratio that 

is irrational (not a fraction of whole 

numbers) – but that’s all I’m saying!  

 

Do you have any other interests 

outside of photography? 

I am just retired from 40 years as a 

paediatric physician, working exclu-

sively in paediatric intensive care 

for the 26 years that I have been in 

Australia. I study Christian theology. 

I have always been an avid bush-

walker and mountaineer. 

Can you tell us something we don’t 

know about you? 

I have never done editing of any-

thing like Viewpoint before!  

I don’t mind declaring that I am a 

committed Christian. I don’t thrust 

this on others, but I hope that I’m 

an example.  
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September 2018 - Set Image of the Month - Digital 

“Arguments” by Geoff Higgins 
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September 2018 - Set Image of the Month - Print 

“Splash” by Tom Brassil 
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“Henry” by Jan Varecka 

September 2018 - Open Image of the Month - Digital 
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“The Mill” by Paul Prouzos 

September 2018 - Open Image of the Month - Print 
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Showcasing - Roger King  
Astro-Photography Workshop  

with Luke Tscharke 

I have, for a long time, wanted to be able 

to take photographs of the Moon, stars 

and the Milky Way.  This is, of course, 

known as Astrophotography. 

Luke Tscharke came to our Club and gave 

a thrilling lecture on his landscape  

photography journey and especially his 

recent work in Tasmania and the West-

ern Arthur Ranges following the trails of 

Peter Dombrovskis.  I gave him a lift back 

to Epping station and we talked about a 

range of subjects and he alerted me to 

an Astro-Photography Workshop coming 

up in August in the Capertee Valley and 

Glen Davis on the western side of the 

Blue Mountains. 

I duly booked and drove to Glen Davis on 

Friday 10th of August. It was a beautiful 

day to drive along Bells Line of Road, 

grab some lunch in Lithgow and drive on 

to Glen Davis.  Apart from getting RBT’d 

in Lithgow it was an uneventful trip.  The 

disappointing part of this adventure was 

the amount of road kill and Wombats in 

particular on the side of the road both on 

the highway to Mudgee and on the  

partly dirt road into Glen Davis. 

The accommodation was inside the Glen 

Davis Works and we used the Poplars 

Cottages (The Inspectors and General 

Managers homes) in the private grounds 

of the Glen Davis Works.  The group got 

together at 2:30, there were 7 partici-

pants, plus Luke and Jay Evans as our 

leaders and instructors. 

The weekend was broken up into  

Tutorial times, Astro shooting times and 

processing or free time.  The timetable is 

flexible and can vary according to the 

weather or other variables.  All food was 

provided and brilliantly served up by Jay 

ad Luke and the accommodation was 

comfortable and warm with an open log 

fire in the lounge room.  Being the mid-

dle of winter I was pleased to find  

an electric heater in my room and an 

electric blanket and doona on my bed. 

The first tutorial was on Safety generally 

and on-site in particular and we were 

joined by John Thirlwall, the property 

owner, for a guided tour of the Works 

and were given a comprehensive history 

of its development and subsequent 

closedown in the 1950s.  We also had the 

opportunity for a sunset shoot over the 

Works and looking west up the Capertee 

Valley. 

We returned to the cottages for dinner 

and a then second tutorial on desirable 

Astrophotography equipment and the 

camera settings for our first shoot.  Jay 

and Luke shared their experience and the 

Apps they used to ensure we were ready 

for the evening.  A key application for 

this adventure was Photopills which 

helps work out the best shoot time for 

each camera and lens.  We also used 

Stellarium to locate and identify the stars 

we could see overhead.  Once outside, 

one of the first things we did was to find 

the Infinity Point for our camera and lens 

configuration.  This is done to ensure 

sharp images of the stars and it may not 

be exactly where the infinity marker is 

inscribed on the lens. 

We set ourselves up in our warm clothing 

in the open area in front of the houses 

and the Milky Way was almost directly 

overhead.  Lots of craning of necks to get 

a view through our viewfinders or in Live 

View (for Canon users) to ensure we 

were focussing on the Galactic Core (the 

centre) of the Milky Way. Jay had  

prepared a laminated cheat sheet for all 

us amateurs in the group. So, for those 

who want to know how to do this, here 

are the settings I used on my Canon 5D 

Mk IV with a 14-24mm Sigma lens.  ISO 

6400, f2.8, 20 secs exposure and white 

balance set to 4000 degrees Kelvin taking 

a single shot. 
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Lots of craning of necks to get a view 

Starry Starry Night 
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Lights in the Night 

We had the Milky Way over the end of the building  
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We drove down into the Works to be 

closer to the Retort House ruins so that 

we could do some light painting to  

provide a point of interest for our  

images.  After trying various ways of 

composing our images we moved into 

the old factory / warehouse and light 

painted the remaining girders and had 

the Milky Way over the end of the build-

ing as it was starting to move towards 

the west. 

Most of us got to be in bed by about 

1:30am but then Day 2 started with  

Sunrise shots; meaning those of us that 

were interested (4) got up at 4:45am to 

be down in the works and facing the 

eastern end of the valley by about 

5:15am.  There wasn’t much happening 

in the East that morning but when taking 

a landscape shot you must remember to 

look behind you and the sun was picking 

up the high points of a couple of  

mountains behind us, so not a complete 

waste. 

Back up to the house for breakfast at 

7:00am and the day was really beginning. 

There was a period of free time or oppor-

tunity to process / review the images tak-

en the day before (and delete the rub-

bish). 

The rest of the morning was taken up by 

two tutorials on Astro Locations and Star 

Trail Fundamentals.  Lunch followed and 

then there were two more tutorials on 

Milky Way Fundamentals and Milky Way 

Post Processing.  The team then ad-

journed back down into the Works for 

Sunset opportunities and found a Hairy 

Nose Wombat to try and take images of.  

The group made their own way back to 

the houses for a BBQ dinner and then it 

was time to get ready for a second Astro 

shoot in the Works.  However, the 

weather had other ideas and there was 

no shooting that night with a complete 

cloud cover. 

Day 3 started early again at 4:45am with 

a group rising to take Sunrise images 

from the same location as the previous 

morning.  This was different with a touch 

of colour over the eastern end of the  

valley and more highlights on the moun-

tains behind us.  One member was really 

keen and had two cameras going at the 

same time (in different directions). 

Breakfast was at 7:00am and then it was 

into training again with Star Trail Post 

Processing using Starstax or other appli-

cations and then for those remaining, a 

session on Social Media, which most 

found quite interesting to hear from an 

experienced used with a large following. 

Then it was time to pack up and vacate 

the Capertee Valley and wend our way 

home to Sydney after an exhilarating  

experience under the tutelage of two ex-

perienced photographers.  They outlined 

a couple of possible ventures in 2019 

which I would have to seriously consider.  

Another benefit from being together was 

the chance to talk to others about their 

experiences and the sharing was most 

enjoyable.  A great experience. 

Garden  

Blue Tongue 
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Galactic Core Explosion 

An exhilarating experience 
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Top left: Prelude to a kill 

Left: Horses Head Rock 

Top right: Terrigal Dawn 

Middle right: Somerset 

Bottom right:  
Soldiers Beach Backlit 
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Avocets IR  (above) 
      Mana Pools Zebra String  (below) 
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Top left: Cuckoo 

Top right: Mana Pools Elephant 

Right: Sabie Sands Buffalo & Oxpecker 

Bottom right: Botswana Carmine 

Breasted BeeEater 

Bottom left: St. Andrew’s spider 
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Sabrina (below)          Family (above)      Callala Bay Surfer (below) 
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Article and images by Roger King 

Left: Turimetta Dawn Wave 

Below left: Terrigal Dawn 

Below: Shady Road 



Viewpoint - September 2018 - Issue No: 143                        Page 22 

 

Our Guest lecturer on Tuesday 4th September was …  

 

200+ people came to hear Ken in 

the Lyceum room and were  

treated to a lively and at times  

humorous account of his 40-year 

journey with his cameras around 

the world. He demonstrated that 

his old, faithful cameras were as 

good as new, and he still uses 

them. Thank you Ken. 

His Take-Home Message?   

A photograph is not a photograph until it is printed. 

Ken took this one, 

which is why he’s 

not in it! 
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Upcoming events include a whole day of training in the use of Capture One raw file editing software on Saturday  

6th October, 2018. See their webpage: https://kenduncan.com/whats-on/ 

Also the very popular Coastal exposure 4-day course on 12-16 April 2019: Go here for details and a video of the horses  

galloping through the flooded creek: https://kenduncan.com/tours-events/coastal-exposure-2019/ 

Ken Duncan Photography offers a number of courses, tours and events.  
Join their VIP club for some discounts and regular news.  
https://kenduncan.com/ 
        Photos courtesy of Ken Duncan 

https://kenduncan.com/whats-on/
https://kenduncan.com/tours-events/coastal-exposure-2019/
https://kenduncan.com/
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A great day out on our Whale Watching cruise day which was organised by Barry Ormond, 

thanks Barry.  

While the day started off chilly and cold the conditions were perfect once we boarded our 

cruise boat for the day out.   Sunny, great visibility and non-existent swell, meaning no obvious 

sea sickness on board.  

Once we left the Broken Bay area and off shore we were quickly rewarded with sighting of 

whales.  For the whole time we were at sea we were accompanied by a pod of whales, best 

guest of 8 plus at any time.  

Distance from our boat was at times directly beside and under us to 30 or 40 meters, meaning 

many opportunities to capture images, although you did have to be quick, as at times there was 

various points of action at the same time.   

Other the opportunity to photograph these wondrous animals it was a great time just  

witnessing their action and play.  

Once again the Members Voting Competition showcased the quality of images our members 

produce, with the top 10 images being separated by 0.6 points based on average.    

Congratulations to Peter Lees for achieving first place with his image Splash 2, With  

Sandy O’Farrell achieved the second highest points based on average with her image Whale 2. 

Coming in third based on members voting was two images from Jennifer Lees and one image 

from Marilyn Coventry.  

Social Club – Members Voting Result 

Whale watching July 2018.  
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Images from Peter Lees  “Splash 2”  & “Splash 1” 

Images from Sandy O’Farrell “Whale 2”  & “Whale 1” 
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Images from Jennifer Lees   Flipping & Dipping 
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Images from Marilyn Coventry    Splash 1 & Splash 2 
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Image from Greg Brown 

Image from John O’Farrell    ‘A Good Day’ 
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Images from Phil Stacey   ‘Whale watch 1’ & ‘Whale watch 2’ 
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Images from Pat Ryan 
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Images from John Tibben   ‘Whale Tail Waterfall’ & ‘Whale Play’ 
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Images from Barry Ormond    ‘Big boy’ & ‘On top’ 
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Images from Tom Brassil 
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Some Images from the  

Landscape Special Interest Group 

BOMBO QUARRY by PHIL STACEY 

Bombo Quarry, Kiama taken on an early morning with constant heavy showers and wind. 
Nikon D810, 0.5sec at f/11, ISO 64,  24mm (Tamron 24-70mm F/2.8) 
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Eurobin 

Creek  

Mt Buffalo, Victoria  

Just below snow line.  

by 

Kevin Hanigan  
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Newport Pool by Ian Moore 

Details – Nikon D800 with 16-35 f4 lens at 22mm.  
0.6 sec exposure at f11 ISO 100.  
Lee 3 stop soft grad and Nisi 3 stop ND filters used. 
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by Colin Wright  
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Cinque Terre, Vanassa, Italy by Gary Elliott 
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HOW TO REMOVE SELECTION FRINGES IN PHOTOSHOP 

by Les Harvey 

WHAT IS SELECTION FRINGING 

When you make an image selection in Photoshop and then paste the selection onto another background, probably you’ll find a 

stubborn ring of pixels around your selection. This is known as an edge halo, fringing or matting. The existence of the fringe 

depends whether the colour of the background image you are pasting onto is lighter or darker than your selection. 

Here’s a common example, the match was selected from a black background and pasted onto a white background resulting in 

the black fringe around the match.  

   WHAT DOES SELECTION FRINGING LOOK LIKE - EXAMPLE 1 

 

 

 

ORIGINAL IMAGE WITH A DARK  

BACKGROUND  
SELECTION PASTED ONTO A LIGHT  

BACKGROUND  

In this example because the 

image was copied from a black 

background onto a white  

background, the match now 

has a black outline fringe.  

If the match was to be pasted 

onto a dark background, then 

the fringe would not be visible.  

A fringe could be any colour 

depending on the background 

it was selected from. 
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       WHAT DOES SELECTION FRINGING LOOK LIKE – EXAMPLE 2 

ORIGINAL IMAGE WITH LIGHT  

BACKGROUND  
SELECTION PASTED ONTO A DARK  

BACKGROUND  

In this example because 

the image was copied 

from a light background 

onto a black background 

the fringe is a light outline 

around the doll.  

Some of the apparent 

fringing is due to the re-

flections off the wall onto 

the doll which is visible in 

the original image. 

However, there is no 

fringe on the bottom of 

the doll as that area  

already had a dark back-

ground.  

HOW TO REMOVE SELECTION FRINGES 

You can remove the fringes manually by erasing or painting over it very carefully, but it’s close to impossible to get a good 

result using that technique unless you have a very steady hand and infinite patience. As often is the case with Photoshop, 

there is more than one way to solve a problem, here are four options. 

1.   Contract your selection 

When you make your initial selection of the original image, use the Refine Edge dialog box (this gives you a preview) or 

choose Select > Modify > Contract to contract your selection by 1 or 2 pixels. Use this technique while you still have the 

marching ants showing your selection.  
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2 Use the Defringe command 

You can use this command after you delete the background (it doesn’t work on layer masks or while a selection is active). 

Make your selection, then delete the background, then choose Layer > Matting > Defringe and enter a value in pixels.  

Photoshop analyzes the active layer and replaces the colour of the pixels around the object’s edge with the colour of 

nearby pixels. For example, if you enter 2 px, it’ll replace a 2-pixel rim of colour all the way around the object. 

 

3 Remove Black/White Matting 

If your fringe is simply black or white, Photoshop can remove it automatically. After you’ve deleted the background, select 

the layer with the object on it and then choose Layer > Matting > Remove Black Matte or Remove White Matte. Like the 

Defringe command, this doesn’t work on layer masks or while you have an active selection. 

 

4 Remove using Layer Mask and Adjustment Levels. 

In this example the person will be selected and pasted onto a new black background.    

 

 

 

1. Open the image in Photoshop 

2. Make a copy of your image by pressing CTRL + J  

3. Select the layer that has the image copy 

4. Use the Select Subject command which only appears 
if you have already used a Selection tool such as the Lasso 
or the Quick Select Tool from the Tool Bar.   

 

 

 

 

5. Refine your selection if necessary 

6. Whilst the marching ants are still visible, press the  

 
to create an Adjustment Mask which will sit 
alongside the layer thumbnail.  
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7. Your Layer pallet should look like this example where the top layer (Layer 0 copy) now 

has a mask with a white frame around it. The black section is the area not selected, the 

white area is your selection. 

8. Click on the bottom thumbnail and press/hold the following keys to create a new blank 

layer, CTRL + SHIFT + ALT + N which will be placed between your 2 existing layers. 

9. Press Edit > Fill change Contents to Black, press OK, this will fill your blank layer with 

black and you will see the light fringe around the subject.  

10. Click on the Layer Mask to activate the white frame. 

11. Using the Polygonal Lasso tool draw a very rough  

outline around the object  

12. Press Filter > Blur > Gaussian > 2px this will 

blur the edges to make the selection smoother 

13. Press Image > Adjustments > Levels and move 

the Black slider almost all the way to the right, 

this will remove most of the fringing. 

                         

 

  

  

  

 

 

 

14. Save and close your file you have finished. 

Move Black slider to the right  

Fringing 
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FINAL IMAGE 

Using the Refine Edge and Decontaminate Colour tools to properly select the hair and beard and remove any colour would 

have improved this image especially around the hair line, as they were not part of this tutorial they were not used. Otherwise, 

this technique to remove Fringing seemed to be easy and worked quite well.  

Good Luck 

Les Harvey    

Castle Hill RSL Photography Club 
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Tuesday 11th September 2018 - Workshop Night  

Morris McLennan  –  Red Square Media  

A workshop covering what accessories a professional photographer carries in his bag.  

Morris is a club member and also part of the training team. 

Morris McLennan is the Principal Photographer of Red Square Media. As a Sydney-based corporate photographer, Morris has 

delivered quality work for a wide variety of clients across numerous industries.  

The Red Square Media portfolio shows the diversity of photographic assignments Morris has completed. This includes a wide 
gamut of industries, including property and construction, fashion, jewellery, not-for-profit, local council, federal government 
and legal. 

Such a variety of clients means Morris is dealing with people who have varying levels of experience in front of the camera, using 
his approachable attitude to get the best out of his subject no matter whom or what he’s shooting. He works closely with his 
clients to understand the brief so the photos fit seamlessly into the media for which they are being produced. Clients use Morris 
for different purposes throughout the year, with the ability to utilise the resulting photos across multiple media from Annual 
Reports to websites and marketing material. 

Morris holds a current national White Card enabling him to meet OH&S requirements for working on construction sites, and is 
equipped with Personal Protective Equipment (PPE). 

As one of the founding lecturers of Nikon School, Morris is proud of the association with this program which teaches  
photography enthusiasts how to master their technical and creative skills behind the camera. 

Morris has been awarded Professional Membership Accreditation with the Australian Institute of Professional Photography. 

https://redsquaremedia.com.au/portfolio/
https://mynikonlife.com.au/learn/nikon-school/
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NOTICES 

Nature SIG – Monday 17th September 2018 at 7.30pm in Phoenix Room 

Portraiture SIG (Portrait Interest Group) Tuesday 18th September 2071 – Gallery 
 Email: Koen vk2zha@gmail.com 

Weekday Outing Australia Reptile Park at Somersby – Wednesday 26th September. 
Meeting 10:00 at the front gate. This event is led by Phil Stacey. 

Entry cost payable at the gate, however, depending on numbers we may get a group 
discount of $25  otherwise Adults $37 and Seniors (+65) $27. Bring your own lunch 
or there is a Café onsite,  and have it at one of their picnic areas in the park. Take the 
Gosford exit off the M1 Freeway and follow the signs our location at Somersby on 
the Pacific Highway. https://reptilepark.com.au/#top 

Exciting wildlife shows and loads of animal interaction are what this hands-on zoo is 
famous for. Get up close to animals during Snappy Hour and meet NSW’s largest 
crocodile, Elvis. Learn how we’re helping save the Tasmanian devil and visit unique 
Reptile, Spider and Frog exhibits. Click here to Register for the Wednesday 26th September Weekday Outing 

Lecture Night – Tuesday 2nd October 2018 at 7:30 in Phoenix room 

Workshop Night – Tuesday 9th October 2018 in Phoenix room – Evan Zell,  
cinematographer and UAV (Unmanned Aerial Vehicle) operator will talk about drone 
operation in photography and videography. Dragon Image will be present to display 
a number of drones of various types. www.evanzell.com.au   

mailto:vk2zha@gmail.com
https://reptilepark.com.au/#top
https://www.chrslphotographyclub.org/store/event/social-event/wednesday-26th-september-weekday-outing.html
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Axholme-Castle Hill Interclub Competition – October 2018 

The set subject for this round of the Axholme-Castle Hill Interclub Competition is de-

fined by Castle Hill.  

The set subject this time is "Landscapes". 

All source material used to make the final image must be the author's original work. 

No images or part of images from the internet may be used. 

Please note that submitted images must not have been selected for previous 

Axholme-Castle Hill Interclub Competitions but it is not necessary that the images 

won an award or have been submitted in the CHRSL competition.  

They can be completely new images. 

Our club must submit 10 Set Subject images and 10 Open Subject images.  

No more than two images across both categories may be selected per author.  

The images are judged by two independent judges;  

  one in the UK and one in Australia.  

The competition is digital only. 

Enter your images via the competitions page on the website. 

The closing date is 23rd September 
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Tuesday 25th Sept 2018 - Competition Night  
Digital Closes: 23-09-2018 <> Prints Close: 25-09-2018 

 

Judge: John Alessi 

The set subject for this month is; “Macro and Close-up” 

Close-up or Macro photography refers to taking pictures of small things or details of bigger objects at close range. 
Traditionally, macro photography is defined as any photo in which the subject has a 1:1 ratio with the photo negative. This 
means that the image of the subject on the negative is exactly the same size as the real life subject. So, no magnification is 
used. Generally a specialized macro lens will be required for a 1:1 ratio. 

We understand that not everyone owns or has access to a dedicated macro lens which is able to do 1:1 so for this competition 
a macro lens is not a requirement. Close-up is defined as closer than one would normally take a photo of a subject. In a  
close-up image you emphasize a feature or an interesting detail of a bigger subject. Many modern general purpose zoom 
lenses (macro zoom lens) have a macro setting that allows you to focus much closer than normal. These lenses are very  
suitable for close-up and can give impressive results. 

An alternative is to use a normal lens (preferably a sharp fast prime like a 50mm or 100mm, longer is better) and mount it on 
an extension tube. The extension tube allows you to focus much closer than the lens normally can. Extension tubes cost much 
less than a macro lens. 

Extreme Macro Photography by Paulo Latues 

https://web.archive.org/web/20081106072156/http:/www.photography.com/articles/types-of-photography/taking-pictures/
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The more expensive brand extension tubes allow you to use auto focus while the cheap third- party ones require you to use 
manual focus. 

Sometimes you see advertisements for screw-on macro lenses which can be screwed onto the front of a general purpose lens 
like a filter. Though cheap, the results are mostly disappointing due to the poor quality of the glass. 

If you want to go really close, you can use a reversing ring (an attachment allowing the photographer to attach the lens  
backwards) but the use of such a set up is very specialized and the photographer must really know what he/she is doing. 

Macro Photography Subjects 

Any small object qualifies as a subject for close-up or macro photography. A good macro photo reveals details and textures in 
the object that can’t be observed with normal photography or by an undiscerning eye. By definition, macro photography  
subjects are endless! Macro photography enhances the details of its subject, of which there are many. Nature serves as an 
excellent choice for such subjects. 

Images for macro photography are limited only by the photographer’s imagination. While nature provides the most obvious 
subjects for macro photography, common items around the house are also possible subjects. These items are readily  
available, they don’t move and you are not depending on the weather. Therefore if you have never tried macro photography 
before, start with a few of these household items and practise, practise, practise. Experiment with light, depth of field and get 
to know your capabilities before venturing out.  
 
Macro techniques 

Lighting is a challenge because it is likely that the camera and lens throw a shadow on the subject so you need to get light  
onto the subject from the sides. You can do this with external flashes or reflectors. On camera flash will not give satisfactory 
results. When working alone, you get the feeling you don’t have enough hands. Some photographers come up with some 
unique solutions to this problem. See below for one simple solution used by Robert O’Toole. 
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The small depth of field not only makes it difficult to get enough of the subject sharp in focus but also the camera must be held 

very steady; the slightest camera movement can result in a blurry, out of focus picture. To increase the depth of field you want 

to shut down the lens as much as possible (high F-stop) but this demands a slow shutter speed or a lot of light (see above) or a 

high ISO (which increases noise). While a tripod at least keeps the camera steady, the location of some nature subjects for  

instance means that tripod use isn’t always possible. Or the subject itself moves, even if it is just a tiny bit will affect sharpness. 

When outside in nature wind, even a small breeze, can move a subject enough to cause blur in the picture. To avoid this, try to 

prevent the wind from reaching the subject. Remember that every living creature moves even if it is only slow. You must adapt 

your technique to the subject you are photographing. 

 

Image by May Hardy     Title and author unknown 

 

https://web.archive.org/web/20081106072156/http:/www.photography.com/articles/types-of-photography/tripod/
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Image by Michael Magin 

If the subject is not moving, you can increase the depth of field via a technique called focus stacking. In focus stacking you 

take a series of exposures while focusing on different parts of the subject and then combining the sharp parts of all the  

images into one. Make sure you operate the camera in full manual mode including manual focus. By the way,  

manual focus most of the time is preferable for macro photography because of better control of what is sharp and what is 

not.  

For those with no experience in macro photography there are many good articles on the web like this one 
http://digital-photographv-school.com/macro-photography-for-beginners-part-1/ 

Macro photography is fun and a good way to learn to use your gear. And there is no impatient model while you are  

fiddling with your camera or lights.  

The judge for this competition is John Alessi. 

We will start the evening with Set Subject projected images, followed Set Subject prints. After the break,  
we continue with the Open Subject prints followed by the Open Subject projected images. 

http://digital-photography-school.com/macro-photography-for-beginners-part-1/
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Castle Hill RSL  

PHOTOGRAPHY CLUB 
 

The Castle Hill RSL Photography Club was formed in 1994 as the Hills Photographic Society.  The club is an informative social 

club with friendly competitions, social outings and events and is one of the largest in Australia and has a current membership 

of around 270.  Members have a diverse range of experience and talent and are always willing to share their knowledge. 

 A strong point of the club is the emphasis on training, with a dedicated Training Coordinator who oversees all aspects of the 

club’s training program.  The main training events each year are a Getting to Know Your Camera day and Introduction to  

Editing images day, both held 3 times each year at a very reasonable cost.  Other workshops on intermediate and advanced 

photography are held regularly depending on presenter availability.  

The club meets three times a month on the first, second and fourth Tuesdays at 7:30pm, 

unless otherwise stated, at the Castle Hill RSL Club 

Call: 02 8858 4800 or go to www.castlehillrsl.com.au 

 

Our Monthly Program  

First Tuesday: Lecture night. 

An experienced photographer, artist or specialist talks about their style of work. 

Second Tuesday: Workshop night.  

A presentation of one individual members work in the form of a short 5 minute AV. 

A short presentation by an experienced club member on Photoshop tips and techniques.  

A workshop night where an experienced photographer talks about how they create their images. This is generally a very  

informal night where other members or visiting experts discuss issues of relevance with the presenter or other members. 

Fourth Tuesday: Competition Night. 

Members submit either digital images or prints to be judged by an independent external judge.  Awards issued to the member 

http://www.castlehillrsl.com.au/
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Fourth Tuesday: Competition Night. 

Members submit either digital images or prints to be judged by an independent external judge.  Awards issued to the  

member counts towards a yearly point score system and a trophy. The judge generally discusses the merits of each photo and 

provides comments on how improvements can be made. This is an excellent way to improve your photography. 

Competition Grading System 

The club has a competition grading system that is designed to allow the member to advance their skills so they can advance 

their photographic skills.  On attaining a standard assessed by the competition committee each year a member will be  

promoted from B grade to A grade. Full details are available in the competition documents on the club website. 

Special Interest Groups 

The club also has a number of special interest groups (SIG’S) for portrait, landscape, audio visual and portfolio production that 

meet regularly during the year. Participation in these groups is open to any financial member of the club. 

Social Activities 

We have outings several times a year with the objective of improving your photography as well as meeting and socialising 

with other members.  

At the beginning of each year we publish our program for the next twelve months. The program varies every year and we try 

to have competition subjects that stretch members’ creative limits.  

The only equipment you require is a film or digital camera, and an interest in improving your photographic skills.  

The social side of the club is very important to us. We like to have fun and a chat during supper and after the meeting. 

Before you can become a member of the Castle Hill RSL Photography Club it is a prerequisite that you are a member of either 

the Castle Hill RSL or Parramatta RSL clubs. The membership application form for the Castle Hill RSL is available here or at the 

membership office of the club.  Unfortunately this means that members must be over the age of 18 so we are unable to  

accept junior members.  This is complicated by the fact that any club members involved in dealing with juniors would have to 

undergo a working with children check which is impractical for our club given the number of members this would require. 

 

Further details about the club and it’s activities can be found on the club’s website,  

https://www.chrslphotographyclub.org 

http://www.castlehillrsl.com.au/membership
https://www.chrslphotographyclub.org
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Castle Hill RSL Photography Club 

Castle Hill RSL Photography Club 

Atrium Castle Hill RSL 

Level 6, 77 Castle St 

Castle Hill, NSW 2154  
 

PO Box 25 

Castle Hill NSW 1765 
 

 

Viewpoint Contributions  

Viewpoint depends on them! 

If you have any articles that may be of interest to our members, please email them 
to: 
editor@chrslphotographyclub.org  
 

Articles could include: 

Camera hints, Photoshop hints, Holiday photography and/or Local Photo-shoots, 
awards, competitions, exhibitions, upcoming events, workshop and Lecture reports, 
recommended Book reviews, reports etc. 

Don’t be limited by this list. Anything that might interest photographers is  
acceptable. 

Please send articles in Microsoft word or plain text format with photos attached as 
separate files. Submitted images should be a JPG file with a size of 1 MB to 2 MB 
(maximum 2MB).  

In order to ensure your article is included in the next newsletter, please submit it by 
the 20th of the month.  

DISCLAIMER: No responsibility is accepted by the Castle Hill RSL Photography Club (The Club) for the accuracy of any information contained in the text, 
photographs or advertisements in any issues of Viewpoint. Information contained within does not necessarily reflect the opinion of The Club, nor does it 
infer endorsement by the club. 

Training Coordinator: 

Steve Castle 

training@chrslphotographyclub.org 

 

Membership Secretary: 

Michael Schwarcz 

membersec@chrslphotographyclub.org 

 

Webmaster 

Mal Hobson 

webmaster@chrslphotographyclib.org 

 

Enquiries Officer: 

Alia Naughton  

enquiries@chrslphotographyclub.org 

 

Magazine Editor: 

Barry Wilkins (Chief) 

editor@chrslphotographyclub.org 

Lecture Coordinator: 

Rick Logan 

lecture@chrslphotographyclub.org 

 

Competition Coordinator: 

Peter O’Brien 

competition@chrslphotographyclub.org  

 

Social Coordinator: 

Tom Brassil 

social@chrslphotographyclub.org 

 

Member Benefits Coordinator: 

Paul Sweatman  

benefits@chrslphotographyclub.org 

 

Publicity Coordinator: 

Julia Zhao 

publicity@chrslphotographyclub.org  

President: 

Roger King 

president@chrslphotographyclub.org 

 

Vice President: 

Graham Gard 

vpresident@chrslphotographyclub.org 

 

Immediate Past President: 

Jason Pang 

pastpresident@chrslphotographyclub.org 

 

Treasurer: 

Gordon Fagg 

treasurer@chrslphotographyclub.org 

 

Secretary: 

Pam Rhodes 

secretary@chrslphotographyclub.org 

mailto:editor@chrslphotographyclub.org?subject=CHRSLPC%20Editor%20Email
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